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1 f VA=)

1.1 PC (WIN9X, ME, 2000, XP) ~DA A b —)L

CD-ROM # a2 Ea—%—D K74 7~ffi A%, CD-ROM WNIZ& % minimoog V Setup PC.exe | 7
AavELTNV -7y LET,

BN =FE—27 VDOA L A=V TH VT aBRLTIZEN, HIHEEE TIE [C:\Program
Files\Arturia\minimoog V] ~A A b=V ILET, DA A M—/VHET 5 VX DT Browse R
A UTCHBERET 522 L CHRICEE TEET,

Please select the minimoog ¥ install folder x|

Setup will ingtall rinirmoog Y in the destination directony...

IE:'\F‘HDGH.&M FILE S %A rturiasminimoog W Browse. .. |

Space Required: 174572 K
Space Avallable: 20025384 K

Cancel |

"Qestinatinn Diirectony

L L

v @)

¢ Back

SR —ILGED T g B

WIZF A A « F 73— (Licence number) & . ¥ D4 (First name) . #(LAST NAME)% == —
Peo S TF A= gy« ULV RUNATLET,

User Information

Lizence number: I

First name; I

LAST NAME: |

Cancel | k.

Tt e T A =g DN

BN =F— 2 VIIAZ L FTa—r « 77U r—2 a0 LTA VA =L ENET,
BWCI == VETS T T AV AN AANELTHERA LW S 74007 e halvky
VST,RTAS,DXI LV #O'E 7, (Znoor v ha/lBET 25 LVWERIZTT ¥ 74 —8 %2 T2 T
W, )
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minimoog ¥ Plug-in Installation

The minimoog % software will be inztalled on your computer. You may alzo
want ta inztall one or more of the following protocals ;

v WST Pratocal
[ [l Protocal
[~ RTAS/HTDM Protool: protocals

™ Protools protocals version B.1 and higher

)8 |

==Y 2 5 PN

VST & RTAS ZiBIR L2 E. == VE2TII7A4 L THERATEERAL - T r—a v
TIEESNTEZTANEEA VA N—NGED T 3 A FITEIR L TFE Y,

¥ST Plugins directory |

Bath:

C:\Pragram Files\Steinberghy stplugi

Directaries:

o ﬂ ok I
[= Pragram Files
[=r Steinbeng Cancel |

B= Watpluging

<

Dirives:

= j Rézeau... |

VST 7°'Z 2 > DA R I G 7 4 /L 55 IR TS5

INTA LY AR—)b s TBTTHITTICA VA M= NVEETTDOICHLERIERN/AISNE Lz,
BIZA A R—L s T ARHBICETLET, LIZOGLSTDHEA VA R—ANRETLTI=F
— 7V EFEHTEDREIZRY £,

1.2 MACOSX~DA A b—)L

CD-ROM # 2> Ea—X—0O K74 7~ffiA%, CD-ROM NIZ&H D [minimoog V Setup Mac| 7 A =
CEETNV 7Yy LET,

[EHEL ] LbRIzDaryEa—4—0 [RRU—R] 2F—kr T4 r—var vy Ry~
ADLET,
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Authenticate

minimoog V Setup requires that you type

Name: |

Password or phrase:

@ Details
|:—'?_:| ’:Cancelj f OK a

gt Ty =g AN

K== VIFRZ KT a—r - 77V =3yt LTA VA =L ENET, N TI=
TN ETTITALELTA VA N—NTDHTTTAO7 v kajz VST, RTAS/HTDM L 0 fif
ALEZWb oA ERET, (Zh b (VST, RTASHTDM) O 7 u ka4 53 LWHRIZTF v 7
X —8 % THMTF IV, )

MR ETCIEI =T VIIT U r—ar « ZHAL~A VA=V ENFETN, A A F—)L
DT 4 AR VA =)L s TN EEBREZENTEET,

00 minimoog V system setup

B standalone application [
& vsT H
[ RTAS [ HTDM O
Lrisk space available: 874 926K Approximate disk space needed: 77 ,820K
— Install Location
= i - L
= Ittems will be installed in the folder ' "Applications" on the H&#
IL disk "Dr-Rotule”
Install Lecation: = Dr-Rotule == v] Install

Ta k2, AR IAIET R T g A KD ER

WIZT A& A« F 73— (Licence number) &, EfH#& D4 (Firstname) . W (LAST NAME)% = —
Pee S TH A=V ar UL RUSNATILET,

INTA VA= Tl T AhITTITA VA M—NERETTHDI MEQM$ﬁAﬁéniLto
BlIIA VA= s O ARBEEICETLET, LIZELSTAEA A F—ANETLTS
— 7V 2R TX5RREICZ D £,
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1.3 MACOS9~DA A b—)V

CD-ROM # 2 B a—H—D K7 A4 7 ~JfiAt%k, CD-ROM NIZdH 5 minimoog V Setup Mac] 7 A =
‘/%fﬁjﬂ/ M 7 U ‘)7 [_/jzjﬂo

BWCI=F—F VETSI7 AL ELTA VAN NAVTETTI TS DT r haikr VST,
RTAS/HTDM, MAS L O fFEHLZWHDE2RONET, (I b (VST, RTAS/HTDM, MAS) @ ~7'=m |
VT AELWVERIZTF v 7 ¥ —8 A2 TSR TSV, )

THE) I=F—7 VX, MacOS9 TIIAFZ N7 u—r - 77U r— gL LTRHENWES Z &
TTE EEA,

DERETHI =T/ VIRT T U v a « TAAH~f VA P— A SRETR, A VX b=
HDT 4 ATRA VARV s TFNE BRI ENTEET,

minimoog ¥ System Setup =———H B
B VST H]
[0 RTAS / HTDM @
O MAS @
[
||
[isk space available: 413 240K Approximate disk space needed: 55 E42K
— Install Location
ez will be installed in the folder “Applications (Mac 0S5
A *on the disk “En-Sys*
InstaIILocation:[ En-Sys £ I | Install |
e

T bl RN y R T A S DER

WIZT A A« F 73— (Licence number) &, 135 D4 (First name) . #(LAST NAME)% = —
P— e T F A= ar - UL RUSNANLET,

Licence : I| I

first name: I I

LAST NAME: | |

[ Cancel ][ 0K ]

Lt e T g A= g DN

AVAPR=)L T TNIBBNI 22— 2 —DFDO VST T3 7 A L DEENTND T V4
FRBE L ET,

Try to find VST Folders automatically ?
[ No ] Yes “

VST =7 4-/L- 5D H Bk 41
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HMNTEDT I r—2 g TCI=F— VEVST T4 LTHERT2003F %N LET,

Check the ¥st hosts installed on your computer
[ Cubase
[ Logic

l ok |

VST 7" &r—2 7 > DR

EL507 7 r—arBBBIRLTE, LY 7 hy =27 T OO NR—Vg opdarta—4
—NICFET A AIE L DNN— 3 U CI=F— S VE VST 97 A L LTHERTA D%
BRI E 9,

Select Folder =""———H

éF‘Iease choose Logic installation folder

W Logic 5Series f

(5 Logic Audio 4.7

= Grey
23 Emagic
33 Logic S Series |

Cancel I oK I

Logic Audio D/N—27 7 > & %R

INTAUVA =L T I AhITTICA VA N AEZRETTEDICHERERPASTENE LT,
BlIA A=) s T AREEMICEITLET, LIEOLTAHEASA A R—RETLTI=
— 7V B TX5RREICZD £,
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2 JAvT - AFZ— |

ZOETIE, S=F—27 VICERBE LATHELL 2D0ERN 2 EELMMH L ET, Blco7a s
TLEMEHAT D ECHER A F—OKTOMELHEN L, OETITEEYy T T b
fe—Z—OFMEZHRALET,

5D A B 2A0HEAR] Tk, BEFN A F—D AFFIZE > THEARZ RS
5 ETROWNCESLSZETL L 9,

EXTENSION

CONTROLERS - —— FILTER

AMPLIFIER

OSCILLATORS

AMPLIFIER
ENVELOPE
MIXER

MODULATION
WHEELS

VIRTUAL
KEYBOARD

MIXER

I ==V HHDOFFr

21 ZVky b EAOERGE

FVFNDOI=F—T LR LTSS, =7 VOREIE N LERA Y bO—203EK LT
BTONREFETELZ L TT,

S=EF—VIITFYEY N RESNEER) ISV AF—DRETORELZEZEATHET, 2h
W« PEE» SN TNAEA L e a ba—F—DT A vy T 4T, LT 72y MNE
DEELEENTNET,

R VOYT T REMDIZOICW ONEAEFNTAHAEL X I,
9. VY FEAD«Bassl »EEATHEL X I,

» «BANK»D EIZHDHRZ %7 Vw7 3THEHEHARERN I ETAVE T« A=a—TERS
BHZENTEET, LCD T 4 A7 LA I121E «Arturian & RSN TWET (Z OFRITIERH
FOLRINENLTWVET), «BANK»D EIZHDIRZ %7 V) v o35 EEHFRRR A7 2T
NE G e Ama—TRRISEDLZENTEET, N7 «M _BlanchetwZ A THEL X I,

Ao a—DNEND EEBERICYT c A=W TWwWE ET, Zhickv o7 T
7 R« FHP A F—D« SUB BANK » & « PRESETS » ZJIEIZEA TW Z R TEX XTI,

» «SUB BANK »® «Basses» % B4l L « PRESETS »®H1 7> 5« IMB_Classicl»Z 3 A THEL X 9,
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FREZET ==
A . | * B
IME_Classic2

E;:T-,I-,t;:an : JME_R.esonantl

M Elanchetn  » Pads IME_F.esonant2

M F'._TT > Percussives IME_Rewverse_k.F

Templates . Sequenced IME_Saw_Acid

IJJIIE » IME_Simplel
IMBE_Simple2

A JMB_Square_acid
IME_Subl

Mew bank. ... DL

IME_Taurusl
JME_Tauruss
IME_Unisonl
IME_Unisonz
IME_Welo_Filkerl
IMB_Welo_Filker2

== VIZEHLNUDEMER 400 FEO T ) £y b EFONHE SN TWET, «User / Temp»
DR T IFEOIEROFEAT L — e 7V vy b ®LI7Vay] PABENRTOHET,
Bl 21T E L« Osonld—RFD T v AL LTEET A7V Yy FELTHESLTWET, 2
NX1o0F VL —F—DEENRT—RA « T4 V2 —%RHALTVCAIZHEDRLDTY,

NLZCA Y DA T 5 CFHST ST, TV PEERIKDTI905 sub-bank DZEZES 1 ZRIIZ IR TS = & 235 A[FEIZ 2 D
FA, PIRITETDON—IEFEZZ =0 BE1T, bank selections D« All » &2 J > 2 | TP 5« Bass » &R L TS 2SI 0,

211 FUVEY FEROTT 4 v b
I TCIEf AR AEREI T CAEL X D,

» 7 Ut v b« IMB Classicl »® 5 &) %, o> EH A H—dD« Cutoff Frequency »> & 4 THHE
LTHELEI, YFIZRMBIEDLLEEAPHLIS RoTc VS o720 LET, IFHDH S
STV I AR L THATIEIN,

EXTERHAL ML ATEN -
. | IMPUT VOLUME

A
| oM L
.= OVERLOAD I o

[} o
-. HOISE LLIME

"
on 1\ : WHITe

CutOff '
235 211.71 Hz

BEOHES S EEE

» [AEkIZ«Range » Y v I EZJEL L TN ZETHVL—H—DF I X —T « LY VEELTH L
MNTEET«Range»V ~ JIANT DX T 6 BefEDOEFEEZ«FEET » TR L E T, FF/ha
BB TEy FIIEmLS @D £, FEEFa—=7138 [ZhoTVET, )
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F:HE:'E OSCILLA Ir:ilﬁ 1
3 1| ' b
(7. 'E s .@
ATOR - '

ATION

P Range Osc1 i B A
an iz, 1 {" & 16' .

1 WANVEFORM VOLUME

LLATI -
FREQUENCY

OSCILLATOR BANK

b V»—ﬁ“*.f(;(- ka%ge ») DEIE
INHOFRELET, TTIZF VY hDO«IMB Classicl &7 4 v hL7zZ L2205, ZoH
T REIFV T AEEE LTRFTHAZENTEET,

y a—H— - T Ut M«user »)~DRIFILY —/b « N—={ZHDH«SAVEnT A a2 %7 Vw7 LE
T, BEOEDOE YT 4 71, TOARNTIELLTIZT VY &AL L TRIFSNET,

HLLBEAEDT Uy b« T2 RN « factory »72o 7286, 7727 F— - 7V ky MIEESHDY
FHA,

» BIOBFICEAERTET DHAIE« SAVE AS w7 A a2 %27 ) v 7 L, BRESFT28ATLES
W, BIZIEAN T O Benew »EIRATLIZEEWN, HILW Uty b ERERIZ 2 DDH LA
VLV TR DEFMELNE T, 4HIIL « new bank ». « new sub bank ». & L T « new
preset» & L TR RINET,

y IRy TRy FEBAHIT Z7) v THIETAMAELRE T LI ENTEET,

JM_I_SIanu:heI:

Templates

Mew subbank, ...

Mew bank. ...

— 5

T s

:. ?'l-:J:._a‘;il By
TVt FORTF

A s

22 HEE—F
==V II2EHEOBEBET—FRLD 7

o «Close»E—RIZAV VI NADI=F—F LREEEOEMEL 72D 4,
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7] Mo N Lulle] WOICES FLAYIMNG FIATRIS | CHORUS | DELAY -
1 ® bt =) MW | i J] o=

E
wte

ENp Mop”

E T = =3

close E— N (FYVFn  I=F—2

ST

EIEIF T4

e «open»E—RNIE, I=F—7 V THAICIESINTHEETHLEY 2L —var v ) vo
AL TNARYZ=H =X LT 7 =27 beBETLHIENRTEET, ZTRHOFHEEICEIY, 2
=F—7 VOFEOAREESLRBL) P EICH ELTWET,

MODULATION MATRIX LFO ARPEGGIATOR STEREO CHORUS  STEREO DELAY

= II! ?— siol | mioi
. SYNC | SYNC
SR

S8 "9@€ 0

N T o o wroion | Eu, || s

HARHERE TH 5 « open » T — N
» «Open»E— NIZTDHIZIF T BV AREY A R Y EHORBAXNVEGZT U v 7T D0,
V=) e N—=DHIZHDH«Open»h X %7 U w7 LTLIES0,

» «Close »E— RIZREDIZIE, I —ERKBNNRXVEDET Y v 7T DH50«0pennihZ %7 >
Lij‘o

GHIZI.F:LIE DELA™Y
-

JLIRISHE TH D « open »E— K& B <

TV TNDI =F—2 DL I I =F—=2"V fEHLEVEEIL, Vb N—Zp B~V Y IR, Z—TF R e TS
F TalA T T2 P TIEL TS S,
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2.3 «CLOSE» E—F

«Close »E— RIX S0Pt « RXT A =X —TAEMREROFEV N TEXET, ZhHD/IT R
—H =DV IRAA v FITEE EBO SIS TE Y 2 — VT BT N—T T SN A T E
KR

INHDNT A—=Z2 =TT OEANPOHER SN TWETS

e 3ATLL—F—(VCO) : 6FFHDY = —7 « 7 — A=A, 2FHD / ax VK, 3EHOHE
BYDA—T 4 AMEHOH N L AEHOEmS (F) 2RELET, 3 FHOF T L—F—i34 v
L= =7 (N —IER DI D LFO & LT T&E £,

o IFXP— : BAVL—F—DHALE AR VxR —F— IBA—T 4 FAHOHE I E I
7 ALET,

e 24db LYV F UK B—/NRT fLH—

e ADST R —7 : m—/RR - T ¢ E—E BRI ETR L ET,

o 1 T7UTUT7AT(VCA) @ TANE—IbDESHEEAT VAHA~EEL TEY HLES,

e ADST Ru—7 : VCA#%HEDHEEEZREMICERL £,

AMDUNT
ATOR - 1 WAVEFORM Ui
UENCT AL

NOLUME  MAIN OUTPUT
e L 5
3

SOFT
CUFFING |
aH

5! 14 \Iﬂ =
MODIFIERS OuUTPUT

TR e NT A= —
R ) — FEAERRLEL LRI LET

» I=F—7 V COHEEVEZIHMBT L0, BRI INRECEZRATEIN, 7V Ey bO
«1_Ose» (« User / Temp » U7 N 7 IZHD EFPHRRNTL L I, ZOFAOREITE THHMT
To AL —F—1 O/ aFVFEOFEFIE, BEHEL—/ X« 7 )L F—Zi@iE LT VCA ~HH &
nTnET,

Oscillator VCO ——» Filter VCF ——————— | Amplifier 3 Audio output
M .

VCA

+ T
i si Envelope Emvelope

—» Audio signal ADS ADS

Yt b «l_Oscr DIFH DT

» B RR e T4 NE—APRDAy AT - 7V y—% FIFTn &, FATEAZ ST HIZ
o TWEET,

Y « Ay AT TNy IEI TV ADOLE 7 Y v 7 THEAENTEE T, (ZHUTT T
OB LTHEHATEET, )

TANE— Ty NETIZADR (7 X7, TA474, VI—R) 2o _"u—7FTERINET,
Y Wy AT e TV —D ADR T _Xu—FIZ LA RIE, VY FUR(«Z T 7 A »)D

fliz 5.00 (2T DEE2EDVDONDETLE DI, I 9 LIZT 4= ROTE I Z«whistlen®D K
REALIERT 255 ICHEITR Y £7,
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» T ARE—T DT X v («Attack time ») DRI AL X THEL L I, FBEHENTOLLENH D
T2 B BALNEL ool VL le o7z LET,

» FILEIICT 471 («Decay time »)ZEZ THEL LI, ; FBEHMNTHLENEEL TV
ECTORFMMPEL o VB o2 LET,

FILIER T
CUTOFF FREGUEMEY EMFHASIS OF CONTOUR
(1
a & a i
FILTER i L ) v 1 -
EXTERMAL MOBEATICN Tw £ =3 - . LR
IHFUT YOLUME . 2
i i

i

CQWFELOAD

LI
WHITE
-

—

| VCF Attack = o
M5 63 ms e o _.1' : s AT :

n o -

T g I — o TN 17— T Dy Attack time » /N T K — K —

TN u—7 1 E«lLoudness Contour » H AT L TWAHDIZZN D TL X 9,
P « Attack time » ZHECTUIZ L7223, HFONH EN Y NRAELS o TnEET,

» [AlERIC« Decay time » & HEC9™ & | A Ui T TV DRI OEREE A EL Zeo T E 9,

LOUDNESS CONTOUR
ATTACK TIME DECAY TIME SUSTA
&Do " 1 o

L1041 1 d L]
Y ' !

MODIFIERS n

P = &7"—5/)’@7‘/7? Fz— NNz — -

24 «OPEN»E—F

R=F—7 V [Z«O0pen»E— RTUUEVAR « RTA—F—DIEEEEZEHT 22 N TEET,
EVal—vay v b v, BEICENTEFS L—F—3 OfRb 0 ICERTS 2 & 8T
Br— . TYrL e F UL B —(LFO), TANRTT—F— a—F A AF LA T4 LA,
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» « MIDI Sync » AA v F D _ODNLEIIHRA N « TFVr—2aOF URIZT 4 LA - &4A%
A SEET, ZOAL v TFRH D2 & TRHIOBRENENEN THINCHERATAD L7
DET, ZOLICKRA L - 77V r— 9 O« Tempo »OIEEEE L THTFIV, Eﬂiﬂ%ﬂ_ﬁl/\
BERFICEE S AR A RE S ERFICRE L ET,

Lamaa Lo te ot e i

MIDI 7//7”/_ Tt %/7@%75 w3

Y RICELET ¥ U HXNVDT 4 LA F O IR LRI % « Feedback Left » « Feedback Right »* ~ I Tili
BLET,

Delﬂ}f Fee{IBacH Left
038
= B

«Feedback Lefty D E

y KRICT—T A - 7 =7 FOREERERIZ« Dry /Wet »Y < 21X H9(Dry :50.00% Wet 50.00%)Z L &

T, THUIZT =7 PO S TR WRE«Dry »& =7 =7 OB« Wet nk DT 2
AL BT TT,

IHEDOWN ONOFEFNTIHEHE L S HIES Z L ICENOPNWEZETLE Y, AAEBIII=F—7 VIC
Lo THRETXHRADFO—TZ T E2BRELELERN, BIE. HEALEOLLbTIChR-EY

DT 4T HERATLLTEE N, TOEVIZBONTE, Fr Loy ZEZ7RL0AESL LAY UF
V7 4 2T 700K EORRIEND TT,
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7 I=F—7 VOEELRE— FTOMAHAGE

71 RAFU R -Tu—v

L= VIV oL I LT ) r—vay (R R T R— s E—R) LT
FERATRE T4, B, F03EEOA VA My AL R &S EF T, 4B MIDI F—R— R CHEZE
THZENTEET,

B XK R e Fm—2 o F— N Windows & Mac OSX D&IZHIE L E T,

711 TV F—T a3 DiEE

R=F—7 V &b EIF5HI21X Windows D6, A=a2—DARE— K >l I357741 >
Arturia > minimoog V CI=¢—7 V 2R UOE¥, vy F L by aTEIAN A M=V LT 414
—EWHE I == VOT AU =gy TAavEZZ TN 70 w7 LTFE,

DRNCRFE L7 7 AN EESEZ ) v 7 LTI == VG LT 7 7 ANV ERLL Z ENTEET,

712 VI 7LV UADERE

FLIT7 LA ULV RUEI=F—27 VAKICEDLLIHSOREEXZITWVET, ZhbDo 7L 77
Lo AT HBIMICREES N E T,

FLT7 LA ULy RUZFERTHITIE : Windows TiE [File > Preferences] . ¥ v ¥ kv
= ClX [minimoog V > Preferences] & 38R L =7,

T
FO0EIN: [pirect ¢ [ v}
B3 | sigmaTel Audio v
B [ra100 M
SBRESHE : 99 ms ;
AIEF Grodlar lv]

Windows D 7L 7 7 L' 2o X« 4 2 R
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(@] i Canfiéuratian

Audio driver = Built-in audio controll | :}

Sample rate ' 44100 )

Audio latency : 9 ms s
1 1 V 1 1 1 1 1 1 1 1

Slider control mode | Circular I:] !

Vo F AT 2D T LR e N

e Protocol (*¥Windows D%) : fEHT LA —T 4 ADO7 v harviE@RIRLES, 7 K- H—F
® ASIO KT A N—%ffi> T 5 72 51X DirectX DOV IZZDOT e ha/Lzfi) = L a2H#5E L £
9, ASIO K7 A /X—|E DirectX D K7 A N— L 37 3 —< V APEITEN TN D 2D TT,

e Driver (FZ4N—)  fEHTIZV TN I—RNIZHIG L RTANN—Z8R L FET,

o  Frequency (V> 7V T VLAR) DU RD—RIJS Uo7V o VR ZERIRL £,

e Latency (FEHFRE) : VU HI—RLara—%—OREICLC CTRERA—T 14 -
VAT Uy —5RELET, VAT UV —RENEYTRWE, THUh BECLIHERHY
9,

e Slider controlmode(/ 7 + E—FK) : ZZTIEY~<IDE— RERIET,

713 A VAPUAAVERIDRE : V—L « N—

WIND T T b 7 —25% MIDI A X2 DA EFOHITHLITY—N « X"—=THRELET,

Midiin 2 Ew/588 MT MIDI | cran:[an x| Keyrange T~ [0 (271 Octave: [0 [ Audio:[Creative Sound Blester POI =] cou: I P )

Windows D>/ —/L « /N—

88 Untitled =

=
T

( N
Built-in audio controller |3 J

| [porra B () Ospit o 127 0
|
Midi input Midi channel Keyboard range Octave Audio channal

TYF A 2D e N—

7131 MIDIfEO a7 4 X2l — g
Y=L« N—OEERSy Midiin (Midi input) TAJIMIDI A > 7> &R L ET,

X =R —REDRNTWNS MIDIA— FEBINL, T2 MIDIF v > R ERELET,
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7132 F—AR—FR - VS—rpar7 4 Fal— g

F—R—=F V= FI=F—F VEF—R—RKCHEHETIHEADOZ L T, HEOGEOEAT v
FL7ZD, LAY—LCHEETHZENTEET, V=L X—=D lzone)] A7 a3 2412 L T
TV, BRECTHELEE TS ERFETOEHATY—FR—F - V=V OREMEZET,

7133 F U Ex—T a7 4 Xal—g

F 7 A =T F R —FDOFEE | A7 4 —7, HBAINNIE A F—TBESEET, HELZVE
FAE I NN— XAV, F—R—F -V —r « T2 9 UNEREES. 2 ORI ERN T3,
7134 F—F o4 oz T X2 — 90

V)b« R—DFEOHTNEII=F—7 VOFHFEHIAR—FE@®RLET, U K — R3EE
DA —T 4 A1 FF> TWDEAIZIE, AR A—T o AHIN Y XA hERRENET, U A B
DOHFNLY T RO DEERINL TRV,

71.4 CPUER=R

Fat RSVl BV UANRT B v HICEZ TWAARL~ILE U T AXA LT
FRLET,

Windows it TlZ, A A ML A b« V— b« X"—|ZA4GKNER RS LET,

Macintosh JR ClL, 7V ¥ T « A=a—b, Cpu ZESEFRINET, bLL, Ya— b
vk, Ta<wy Rk¥— (8) +L) CHLREEOZ EMTIET,

VEE : COFRIZ, BFELEKICHET IS 7 rt o PDRGDARZRL TEY, OS e 500D X T LADEA e L T
NWBSDTIED Y EHA,

715 R=v e

J = DB Y X LICRY, EFOLTHIEESLRWEIL, £ ToFELXIED S MIDI A viE—U %k
BTrzenTEEd,

Windows T80y — « s—thp X7 4 av %70 v LES,
Macintosh TiZZ D2~ KiZA==—@ Help > Panic THONY F7T, Ya— Iy NI <
K¥— (8) +47> a3 (X) +P) TF,

716 A VAbRwAL hOBRE

A VARNTNVAL DRy F T ) TER, EOMA—T 4, MIDI 27 (X2l — g%
TEEOTBEORELZRGFT LN TEET, RIFTDHICE, 7740« A=a—D00RELR
S0, bLLIE, 77 A0 s A== bW EMIT TRE..ZEINL T, HLWARTE ST TRF
LET,

HE : S=TF—2V TTL 77 L AREFRIFTEHE, 7Vt FEFEEDRFIITNVELA (413 =2—F =TVt pbD
RIFENE) T 7Y Lr—2r g > TOREIL, BIED TVt F FEEHRORIFES GA TOEEA
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7.2 VST™
721 A VAR b—)v

72.1.1  Windows DH

AA M=, TITTA DT —~y FPORREE T VSTA 7 v a a2 RL T ZEN, A
YA N=TX, BBWIZ VST 7774 « T H—ERH L, A A h—L S ET, o VST
HPEZ > — o % — (LOGIC %) DOBEITIE, WU 7 4NV F—IZT T 74 DT 7 A VaF
HTat —FT 508N ET, ZOHAIEFEA A N— DK, 4K S LD «C:\Program
Files\Arturia\minimoog V\VSTPlugin» 7 # /L % —H1 D «minimoog V.dll»Z = &°— L TEH L £ 77,

7212 MacOS9 DA

AVAN=NVRIT, TITTAL DT F—~y FOBRER T VSTA 7> a 2RI L T ZS 0, A
YA M=, BEWO T —5 o —(Cubase, LOGIC %) THEHT 2/ 3—F ¥ L « £ A by /LR
VRERMLTWD 7 AV — 2 HEIBICHRE L, BREMERELET, BRI TUIA VA =T
NHBICBEN D= P —DT T T s T A F—Z BN bbb 9, 20
Bt TROZ 7 AN EBHFECOY—F o —DT T 7 « THNT—~FETaL—F5Z LI
Ko TTHEHMNATEEIZ/2 Y £7°,  «Applications/Arturia/minimoog V/VSTPluginy»

72.13  Mac OS X D

A VA RN—NHIZ, FITTALDT+—~<y NOBRINEMI T VST 72 a3 VBN L TL SV,
VST 77 7 A 0%, VSTA VA MoV AU VIZHIG LTV AT b s 7 VZIZEBIZA A h—)b
EN. VSTOKRAR - T F U r— g il TERTAZ ENTXET,

722 VSTAVAIo AV LTHERT LSS

==V ZVSTT 774 LTHERT 56, o VST 7T 7o 2 LRBRIC ZHEMIC e &
T, FEIIARAR = o —Da—HW - v =2 T A EBR LT EV, Cubase SX TIEHIZ
725 %6 . «Peripherals / VST Instruments » A == —Z BT 7 > 7 OH17> 5 [minimoog V| %8R L
TRF&EW:

€ ¥ST Instruments X

v Mo YST Imskrument

LM-9 3
Synths k

Meon g

Skarm

Windows /& Cubase SX T3 =F—2"V #&/H7 5

723 MIDI b v 7 L DR

R=%F—27 V% MIDI b7 v 7 LB MTHEEIESIZIE MIDI b7 v 7 #380Y,  (Cubase D
B) Ama—0bliHTS 7 vy 7O MIDIH /)L LT minimoog V) Z#IRL £ :
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X
n
L]

X
n
[ ]

€ & €
X
n

X
0

w Mot Connected

L ]
EEE R B AR A R A R R R A

e

MPL-401
Mappeur MIDI Microsaft [

Synthll, SW table de sons G5 Mic [
Synthe, S kable de sons G3 Mic

I N

I ®x]s
@ [xIs
@ <= |

LA ]

Lll= L)
A= Al=

S=F—2V #MIDI } 7 2 *EHETS

MIDI ¥ —AR— RTEHEBEESNT- MIDI A X2 MI—F o —%2EUTCI=F—27 VICEEINET,
HEHALINHD MIDL A XY b &S THZELAHRETT, LTy —7 2% —0 MIDI =5 4 v
MEREETEERT B ZENTEET,

724 TUtkvy FOBRE

o alrERETHE, TV Y FEEARELEFATHH-THI=F—7 V TEIELZIERITET
SNFET, BlIzIET VY FDO«Bassl a5 v b L7zb D&« Bass2 »& LTHRIFELTWARL T
b, WICFOHEZWIESI=F—27 VOF Uy b« Bassl w2 H LI-BANEFEISNLTWET,

VST SIEDHRA R « TF VI —3 a0 DA=a—InbT T304y « £ ANy LAY MIET AHHE
ERAATHZEHAMEETT, L, BICHRERRWGE, I=F—27 VOV —/L - X=7bRFT
HZLEBREDLET  ZOFETHREENETV By MIfhOET—F (RZ R T7Tr—r, o
Y—rug—) THEATE, ML 7 AL LTE S R — bAFRETT,

725 A—FA—vav
I=F =7 VAOBREIMD VST 77 7 A » LRETT GEFC DS E LTI VST V=7 v =D

FTIAy A= A —va VEEOHEEBEZSZRTIWV), YV tEy hOEHIIA—MA—T a3 vbT 5
ZEiFTEEEA,
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7.3 PRO TOOLS™

731 A VAR b—)v

A VA N—)VEEZ, Install as a RTAS/HTDM plug-in %334 L £3 (RTAS 1% Win D %)
RTAS & HTDM 7’7 7' A U BINO G2 7 AN H —%RINT 57 7 — b3z & & IRONSRRAEFFE
LTL7EEN,

e Mac OS 9 ;4 : System Folder/DAE Folder/Plug-Ins
e Windows ®#;4: C:\Program Files\Digidesign\DAE\Plug-Ins

ERALTCWA AT AN, HIDM 777 A4 U EFRT A2 HEEZMDT, 4 A M= VZR 2720 &
7,

Mac OS 9 FTTiZ. DAE DA EVfHELY 15M A1 MREE THOTSLERNLY £4, (ZOFIEX
Pro Tools D~ == 7 )VEZHMRIIFE W)

7.3.2 RTAS & HTDM

2 =%—7 VX, Digidesign ® K7 A /N(DAE) L 2D T T /A v « A T TEELET,

e RTAS (Real Time Audio Suite) 77 74 > & LT
2T D Pro Tools VAT MIBWTHBMOH LT T 74 « A4 7T, SREROETITHDND
A%k CPU T LET, FD7=H, TDM P AT LD X ) REEEDILEY — REeNE L L
lo TDM ¥ AT L TlX, RTAS 77 74 %, TDM 77 74 LY bEICA Y — T 508
NHYFET, F2, Aux AR, ¥ RAH—« T x—HF— (21X, TDM 77 7 A » OLBPFEHAAIET
7,

e HTDM (Host Time Division Multiplexing) 77 7' A > & L C
TDM v AT A (D7 EH 1KLL ED DSP 1 — R&EfH A 726 D) IZR-> T, 0S9/X #iz, ZDX
ATDOTZ7 A &R LET (Windows iiiO HTDM ~O %22V Tlx, Digidesign (D~4—
LML TLIEEY) , HIDM (X, TDM 77 7 A > L &< [ARICEEL £ (f > ¥ — MiE
OHIRELH Y FHA) . 7227212 TDM 77 74 > L& 5 5%, DSP I — R&ff fE41c
CPU Zffi» THELZITH &\ 9H Z & TT,

FNENDL AT DIBIT DT T 7 A OH M

Mac OS 9 and X Windows 98/2000/XP
TDM ¥ AT A RTAS B XU HTDM RTAS
(stereo in/stereo out) (stereo in/stereo out)
T OMD T AT A RTAS (mono in/stereo out and stereo | RTAS (mono in/stereo out 33 2 T}
(Pro Tools LE, Free) in/stereo out) stereo in/stereo out)

733 A VA bFwnAvREREL

J=EF=S VT T ERICE, WOT T YA Rk TROFITRLTNS X )ic, A—7 4
A Ty AL ET
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< (™ 4) sam23:15

Kl E NrEeC) « CymiiT T
Pro Tools for Mac OSX T3 =F—2"V /<

o TDM VAT AL : =%~ VIIT7A40F, AT VA NI v ZITHASINDILERDH Y 77,
HTDM 75 7' A > %B<IZiX. TDM DOV T A =a2—ni_ HIDM 75 74 V23R L E 5,

o ZTOMDIAT AL I=F—F VII, £/ AT 44 FTvr FHABRATVLUAICRD F
T) LI, AT VA oA —FT 44 FT v TITHAALZ EBRTEET,

TR, T TARNAR—F )L« F—R— RE2lioTCI=F— 2/ VEEET LN TEET,
734 MIDI F5 v 7 L DG

S=F—7 VIEMIDI b7 v 7L DOFERTHETEET, FHLZW MIDI 4 >V F—7 =2 — AR
MIDI F % > R OFERROBEE T A2 LEST, I=F—7 VIIF—AR—F2ELTCar b —/LTX
T (ZOFEEHOT S, ZADEERIZTOW T ProTools v+ =27 /L&a TR FE N, )

735 FUky FOBRE

—HEevrarvaHLbE, 3= VEZTOLEOWRELZEBMICHREFELET, 7V By F&24E
HALTWAbE, #lziE7Y Yy D« Bassl »25 v hL7=b D%« Bass2 »& L THRIELZRW
LAY, WICEFOHEZHWEEASI=F—7 VOF Uty b« Bassl B EEHMEFESNLTWVET,

Pro Tools M« Librarian Menu »l%, D75 74 v LREBEICHERATAZ N TExES, LL, /v F
DE—T1F, S=F— 2V VHETDOA=2—TE—T7FT52L2BEDLTWET, FOHMAIT,
o MREFEINETVEY M, O —F o —THEATE 2720, EVbi), 22— —FH LT
—HZDRN LY NLRTL ) FT,
o LBNR—Ta T vl ENTWI=E—F VT, BELERNYyFERIZIENTE DD,
(AL H AA)

73.6 ProTools IZBITFTAA—FA—T g3

F— A — g UHEREIIfth® RTAS/HIDM 75 7' A v L EREICHSRE L 4 (o971 v DA — F A—
g VESBEDTERIIZ SN TIE, Pro Tools D~ == 7 V% ZHRBIFE X)) . Uty hoOSy FEE
TAHEA— M A= a I ENTEERA,
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74 DXi™
=F—7 VIii, DXi 7u bajt y AEEZFL, SONAR™M 30 21X 0 EdT5 DXif v A by
w%/F%E%T By — Y —THEHT LI ERAHETT,

741 A VA b—)V

%Iyyb‘4“*“””#%TTéifﬁ@®%ﬁ;%of¢@1<témo4/xk~w%7&
T CIEDXiA v A My LAy b E LTHANAEETT,

742 A VA bRy AL FEBEL (SONARY2.0)

« Insert » A = = — 7 H« DXi Synth » Z i8N 7 A = 2 —7)>5 [minimoog V| AR L £ 7,

Inserk Transport Go Track Tools  Options  Window

BankiPatch Change... (] (RGO (. .2

Meterfkey Change. ..

N tompo Change... {1 | o NI I

Time/Measures. .. A thga ™
= C3
U Marker.., F11

Series of Controllers, ..

Series of Tempos...

D Svnkth Cyclone
DreamStation DEi2

Rewire Device r
Audio Track, !\!)

WaT k

MINT Track

Dxi 1> X p X hEH

«Synth Rack » 74 > RuNBINET, I =F—7 V O % 31213« Synth Rack » A = = — D4 il
EETN )y LET,

743 MIDI K5 v 7 O

I=F—2 VA MIDI b7 v 7 b ENLEREZETE L LT DICE, =7 —orf
DA==2—%fH LT, MIDI FZ v 27 2%, HHT 5 87 v 27 ® MIDI i /155% minimoog V |Z5%

EL TR,
2 | = MIDIT o|
is FPan Vi=
Mame 1 -mPL-41001

Mone v 1-MFPU-401

Barik m
ru:nne_ L ey Drum Map k

Drum Map Manager, ..

MIDI 7 w2 & 3 =F—2"V DEERE
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MIDI % —7R— R TEHEENZZ MIDI A X MEISONAR FOI=F—7 VIZEEENET, bHAA
OO MIDI A Ry hEEETHIEHAAETT, £ LTSONAR D MIDI =7 ¢ v MERROETE
ATz ENnTEET,

744 FVky FOBRE

TuaYlxl FERFET ATy MRS L TWARNWT B 7T A TH-Th I =F—2 V OIFHR
BHREENET, 7V By bEEALTHARLIE, Hl2IEZ7 VY b« Bassl »&2T5 4 v b
L7zt D% «Bass2 »& LTRF LRV TNT S, RICEDOMZHWESGEI=FE—27 VOT VY I
« Bassl »WIEBEEFTHARIFEINTWET,

745 A —hrA—Vav

SONAR TA— FA—1 g v OSEXRITHICIE. I ba—v - Fz2MIDIA vE—V 58S LT
Ty S=2F—T VDARAF R Tra—r «F—RFLEEFRICMIDI A X2 hEo—r AV 7 MG
o he— L LET,
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7.5 DIGITAL PERFORMER™

751 A VA bP—)v

Digital Performer3 O35

AVAN—ABRHER LTINS T 7 A DT 4 —~y hOHnG MAS ICF =y 7 & ANET, 1=
E—7 VIZHBMIZ MAS 77 7' A > « 7 4 )V 2 — (System Folder/Extensions/MOTU/Plug-ins) ~A >

A=A ENET, 089 TI=F—7 VEZMAS 7771 & L THHT 5541 Digital Performer O
AEY - T mr—v gk ISMBREEICHROT Z EALETT,

Digital Performerd D54

OSX | T Digital Performer4 % BV OHAIE, I =F—7 VIFHBMIZAUA VA ML A R ELT
A VA=V ENET,

752 A VAMVAYV FERHEL

Digital Performer3 D4

R=E—T NI ITAEND BT AR, o7 Z 74 VRRRIC, A—T A - 8T v iAo
—FLET,

Fi Track-1

PiTrack-2

PiTrack-3

PFiTrack-4 ~'Marne

&= Audio-1

= Audio-2 AutoPan (sterea)

= Audio-2 elerb™ (zteren)

= Audio-4 Flanger [sterea)

& Audio-5 minirmoog Y Cstereo)

M5 Decoder [sterend
Multimode Filter™ (sterea)l
MW Compressor (stereo)
M Gate [stereo)

M% Limiter Cstereal

as Fulti Effect Example W

Digital Performer3.11 T3 =F—2"V /<

& Audio-&

R=F—U VI, B SATULAELLDA—T 44 - b T v ZIlb AT I ENRTEET (£
T v s iCERA E BEIMICAT LA - F T v 7D £9)

RARADRITT T ARLN—=F ¥ )b« F—R—FEfio TI=F—/ VEHEET LI LA TEET,

E\IH

Digital Performerd D&

Digital Performer4 ™ A = =2 —/3—"7T [Project>Add Track>Instrument Track] Z&RT 5 &, A A h—
NENTNDAUA VA My LAY NESLD BIF L2 LN TEET,
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Audio ETIEEH Studio Setup Windows AL

Midi Track
Mono Audio Track
Stereo Audio Track
Surround

Aux Track
Instrument Track

Delete Tracks
Madify Conductor Track

Arturia: CS-80V (stereo)

Track Groups X146 |
Modify Track Groups » | Master Fader Track ~EM minimoog V (stereo)
Moog Modular V (stereo)
Sequences > 1702 |2 oo o s Apple: DLSMusicDevice (stereo)
Chunks rC g i g i i i i ' 1 Unassigned
= Tracks oT h
T T T T T
= Sequence Editor s
= Mixing Board M
= Effects F
— Markers K
= Graphic Editor G
— Notation Editor N
- Fvent Lisr

DigitalPerfoh:neM.IZ TI=Fc—2V#F<
MRIABIRIIT T ARN—=F ¥ )b« F—R—NEflio TI=FE—V VEEETHI LN TEET,

753 MIDI T v 7 & Ok

MIDI DX ET D &2 E - T, MIDI 2@ U CIEETHZENTEL L ET, 22Tk

EF L72WMIDL A % —7 = — AR, MIDI 7 v > RV OFERROBIE {1 %2 L E 9, Digital Performer

@ OUTPUT D#IRT, #EHEiL T\ D MIDI HIREFRICI =F—2 V Z2EIRTH LN TEET,
("F X Digital Performer4.12)

1T End] | 1y ¥ ] |:
4 LEVEL FLAY KHMFT OUTFUT TRKE 0L TEACK HAME FATCH _

1 4 Conductor
— » minimoog V-1-1 1  m JTrack-1/1
— = sna0-2 1 M b Track-1/2
- S5D80-3 1 M b Track-1/3
= SDe0-4 1 b Track-1/4
.| | 5D80-5 1 M b Track-1/5
I SDA0-6 1 M b Track-1/6
I — — Ml b Track-1/7
= None Ml J Track-1/8
— =M Bl b Track-1/9
— =i - =l b Track-1/10
— > 1 IAC Drfver [ ] Bl 3 Track 1711
=l MUTO00 P B Track1/12
— =M SC-8850 > ml b Track-1/13
— =N Bl b Track-1/14
| Rt P b Track1/15
— =M spso p | B S Track1/18

L V3080 > __| = minimoog V-1

X\-88 >
rmirimoog V-1 | 2 minimoag V-1-1
1 minimoog V-1-2

Mew Davice Group... minimosg V-1-3

minimoog V-1-4
minimoag V-1-5
minimoog V-1-8
minimoag V=1-7

Pl VLT R

I=F—2V &MIDI |7 2 & DL
F—A—FEHEHLTCI=F—27 VEAHETHZLHTEET (ZOREHEOT A ZRDOHHEIZDONT
IZ Digital Performer D~ =27 L% THBI X, )

754 TVt y FORE

—Htv arEALsE, I=F—7 VIIZTOLEOREZHABNICREFELET, L T
A= HEBFE L7V Ey b« Bassl »&2t—7LAWTHULEI, kE, Zoiovtya s
BIW/-E &, S=%—7 VIZEEICARTA—XE2ET L7Vt > b« Bassl »&itriABLEzT,
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Digital Performer @ saving plug-in parameters #§81%, X =F— 7 VIZBWTH, b HLAAEHATHZ &
RTEET. Lirl, RyFOE—T1h, 28—/ VAROA=a—Tr—715 2 & &5n L
TWEY, TOHEMI,

o RfFSNIET VY PR, MO —r o H—THHHTLD, &b}, 2=V —FEtDT—
AR LRI ET,

o LR, N—=Valr 7y TENTWKI=ZE—7 V T, REFELERNYTFERS Z LN TED2D,
(7 A 41)

755 F—bhA—var

A—h A= a UREEIIMO MAS 777 A v EFRRICEREEL T (T 7 A DA — A= a v
FEBEDFEMIC SV T, Digital Performer D~ =27 L& ZHRLIEEW) . Uk y hONyFE2E
BF o4 —hA—va il ENRTEERA,
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8 BHIDE— - AP —6 TAEE T
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